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View Prosthetics Billing Information User Manual

Overview

I ntroduction

Audience

Data displayed

January 2005

This View Prosthetics Billing Information User Manual isfor Patch RMPR* 3* 96.
This patch provides Prosthetics GUI (graphical user interface) windows for the View
Prosthetics Billing I nformation feature.

The Prosthetics and Billing users will be able to do the following with this patch:

Search for data and display data by arange of dates.

Sort and rearrange the view; display datain a custom view.

Print the display.

Convert the display into a Microsoft Excel file (for more complex sorting
capabilities).

These Release Notes are geared towards two audiences. The Vista Sign-on window
will appear with different functions according to which type of user is accessing the
Billing information. The two audiences for this document and the Vista Sign-on
window include:

e Billing users— Section 1
e Prosthetics users — Section 2

The datathat is displayed on the View Prosthetics Billing I nfor mation window
includes the following:

Site

Create Date
Delivery Date
Patient name

Socia Security Number
Insurance

Coding Errors

Item Description
Quantity

Total Cost

HCPCS

HCPCS Description
ICD9

ICD9 Description

View Prosthetics Billing Information 5
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Section 1 - For Billing Users

Billing Main Menu Window

Billing Main Below isthe Prosthetics Main M enu window where Billing users can first sign-on

windows to VISTA (using the Vista Sign-On button) and then access the View Prosthetics
Billing Information window. The Billing userswill see a“green dollar sign” icon
on the desktop to select the Prosthetics feature.

Note: Please seethe Prosthetics Main Menu User Manual for more detail
information regarding VISTA Sign-On instructions.

Prosthetics

Main Menu
M VISTA Sign-On

% View Prosthetic Billing Information

Prosthetics

Billing button Click the View Prosthetics Billing I nfor mation button and proceed to Section 3.

January 2005 View Prosthetics Billing Information 6
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Section 2 — For Prosthetics Users

Prosthetics Main Menu Window

Prosthetics
Main Menu
Window

Prosthetics
Main Menu

Billing button

January 2005

Below isthe Prosthetics Main M enu window where Prosthetics users can sign-on
to VISTA and then access the View Prosthetics Billing I nfor mation window.
These users also have access to other Prosthetics features.

Note: To access this application, you will double click on the Prosthetics VISTA
Suite (medicine bag) icon on desktop. Please see the Prosthetics Main Menu User
Manual for more detailed VISTA Sign-on instructions.

% View Prosthetic Billing Inf

) Delayed Order Report

#{ NPPD Detail Display [

Prosthetics

Click the View Prosthetics Billing I nfor mation button and proceed to Section 3.

View Prosthetics Billing Information 7
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Section 3 — View Billing Information Package

View Billing Information Window

Purpose Y ou can view Prosthetics billing information, insurance information and disability
information for specific veteran using the View Prosthetics Billing I nfor mation
window.

V|e’v EaView Prosthetic Billing Information... You are logged onto DEY =13l x]

Prosthetics el

BiIIing Please enter a range of dates to View Prosthetic Billing Information
Information

Begining Dete: INEIE| Ercino Dot EE]
_site | Create Da [Delivery D..|Patient__[Ssh_Insurance |co

main window

E-M

=
3
Insurance Infomation

Dizability Infarmation
Expires - A Disability

SInsurance COB |Sub ID |Group |Holder |Effective

@ Menu | Records Found : 0

|click on Header to SORT or MOVE

Menu button The Menu button will close the View Prosthetic Billing Infor mation window and

return you to the Prosthetics Main M enu window.

January 2005 View Prosthetics Billing Information
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Enter a Date Range

Date/Calendars After you have successfully signed onto VISTA, and the View Prosthetic Billing

Calendar for
daterange
selection

January 2005

Infor mation window appears, you must select the date range that you want to view.
Enter a Beginning Date and an Ending Date by clicking on the drop-down list
boxes next to the respective fields. A calendar displays as shown below.

Note: The software will sort by the Create Date field of the Prosthetics Purchase
Order or Stock Issue. It does not sort by the Delivery Datefield (the date paid).

Eaview Prosthetic Billing Inforr

lﬁ Help

Select Begining Date  Cirl+B
Select Ending Date Cil+E

Displary Cirl+D
Frint Cirl+F
Excel Clrl+x
enu Cirl+C

Shortcut: Pressthe <Ctrl> key + <B> key for the Beginning Date and the

<Ctrl> key + <E> key for the Ending Date to display the respective calendars. You
can aso click the File Menu and the Select Beginning Date or Select Ending Date
option from the list.

Ea\fiew Prosthetic Billing Information ... You are logged onto DEY - |EI|1|
File Help
Fle ge of d 0 Pro B g 0 0
Begining Date: (Sl IR=IEN i ding Date B Displa <5 Print 3% Excel
—Site |Create Da, |Delivery D, |Patient |SSH Insurance [Coding .. |Tkem RiessltoldisplayiEndngDatelEalEndaj Desc |ICDY ICDO Desc

Sun Mon Tue Wed Thu Fri Sat

- 2 3 4 5 B 7
g 8 1w 11 12 13 14
1% 16 17 18 19 20 A
2 23 24 X% 2% 7 M
28

Today: 9/20/2004

o o

Insuwrance Information Diizability Information

““Insurance OB [Sub ID |Group |Holder [Effective  |Expires - - Disability %o |SC -

= [=
@ Menu | Records Found : 0
|Press ta display Ending Date Calendar v
Continued on next page
View Prosthetics Billing Information 9
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Enter a Date Range, Continued

Selecting a date
range

Number of Day
Restrictions

Date Range
M essage box

Start Date
before End
Date

Start/End Date
M essage

January 2005

The calendars display with the current date circled in red shown at the bottom of the
calendar. Y ou can accept the current date by clicking onit. You can also change the
date by the following methods:

Changethe... Description
Day Click on the actual day of the week in the calendar.
Month Click on the month at the top of the calendar to display alist

of al months and select one from there. Y ou can decrease or
increase one month at atime by clicking the left or right
arrows.

Y ear Click on the year and an up and down arrow button displays
for you to increase or decrease the year.

You are restricted to a date range of less than 100 days. If you select a date range
outside of this 100 day parameter, the following dialog message box displays:

oformation

You have selected a range
af more than 100 days,

If you accidentally entered an incorrect date range, you will receive awarning
message. For instance, if you enter a start date that is after the end date, the message
below will display. Click the OK button and reselect your date range.

Information x|

@ The Starking Date must be before the Ending Date

View Prosthetics Billing Information 10
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Display the Prosthetics Data

Display the
data

View
Prosthetics
Billing
Information

January 2005

Once you have selected the date ranges, click the Display button to reveal the data
within that date range. (You can also click the File Menu and the Display option.)

A progress bar activates, and the button name changes to “ Searching” while the

system isretrieving records. (A long date range may result in along search time.)

Recommendation: The larger the date range selected, the greater timeit will take to
search, sort, and display the data. We recommend that you sort by a short date range
(5-10 days) and perform the sort early in the morning or later in the day when your

VISTA systemisless active.

Shortcut: Pressthe <Ctrl> key + <D> key.

EaView Prosthetic Billing Information ... You are logged onto SSCSL

File Help

Please enter a range of dates to View Prosthetic Billing Information

Begining Date: NEAREIIEEE i Ending Date: [YETRERICE ke

—Site | Create Da.
BAY PI 1/13/2004
BAY P1 1/13/2004
BAY PI 1/13/2004
BAY P1 1/13/2004
Bia P 1/13(2004
BAY PI 1/14/2004
BAY P1 1/14/2004
B Pl LILE/Z004
B&Y P 1/16/2004
BAY PI 1/16/2004
BAY PI 1/19/2004
BAY P1 1/19/2004
BAY P1 1/19/2004
BAY PI 1/19/2004

g =[5

1142004

Delivery D, [Patient  {S5N Insurance |Coding .. |Tkem Oty |Tobal C.. |[HCPCS  |HCPCSDesc  |ICDG  |ICDQ Desc &
1/13/2004 | GUHYIE, 51 009-38- *MEDICARE R 9 36.00 E0443  PORT 02 COMT
1/13/2004 | CHEYTHY,HO60-25- *MEDICARE Alert HCP1 ~Re 1 49.00 |E1401 |OXYGEN COMI
1/13/2004 | CREYTRY, b 060-25- *MEDICARE faatied 4 16.00 E0443 PORT 02 COMT
1/13/2004 | CHYHT,AA 300-24- *MEDICARE Alert HCP1 ~Re 1 49.00 |E1401 |OXYGEN COMI
1/13/2004 | CRTHWE,{ 264-28- MO HEALTH Alert HCPy ~R~ 1 49.00 E1401 OXYGEN COMI
1/14/2004 | ALIELYIH, 019-33-! NO HEALTH R 9 36.00 E0443 PORT 02 COMT
1

11192004
11192004
1{19jz004

Insurance Infomation

ALIELYIH, 019-33-! MO HEALTH R

Eeh AP TE

BisMAXPTE 307-03- *NO HEALTI POSTERIOR INTF 50 |5940.00
BisMAXPTE 307-03- *NO HEALTI BLANKET 13 3686
BsMAXPTE 307-03- *NO HEALTI ELASTIC SUPPOFZ 25,12
KLRHL PO 713-00- MO HEALTH Alert HCP! e 1 4900
KLRHL P 713-00- MO HEALTH e 7 zaon
KHUIYISTX| 031-00- *MEDICARE ™ 10 40.00

Dizability Infarmation

E0431
| 8739

vae3zt

Lg239
Lgz39
E1401
E0443
E0443

PORTAELE GAL

POSTERIOR IN
ELASTIC SUPP:
ELASTIC SUPP!
DXYGEN CONI
PORT 02 CONT

3% Excel

PORT 02 CON1 h I
»

SInsurance COB |Sub ID |Group |Holder |Effective  |Expires

MEDICARE (WhH
MO HEALTH INSL

32118 PATIEM 02/14/2002 02(14/2002

PATIENDO/00/1989

A Disability

POST-TRAUMATIC STRESS DISO
KMEE COMDITION
SEPTUM, MASAL, DEVIATION OF
CONDITION OF UPPER. DIGESTIVE SYSTEM 0 YES

& Menu_|

Records Found : 1255

|click on Header to SORT or MOVE

View Prosthetics Billing Information
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Change Data Display

Changing the Y ou can manipul ate the layout of the view in the View Prosthetics Billing
display of the I nformation window for both viewing as well as printing purposes as follows..
data...

e Toenlarge acolumn, click and drag acell border.
e To sort on any column, click on the header to sort it in ascending order.
e If you click on the same column again, it will sort it in descending order.

Refresh data If you have changed the sort order, you can refresh your data by clicking the Display
button again.

Note: Refresh does not reset any column resizing that has been done.

January 2005 View Prosthetics Billing Information 12
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View Column Descriptions - Site, Dates and Patient Data

Site

Create Date

Delivery Date

Patient

SSN

Column
Headers

January 2005

The Site column displays the VA facility where the veteran was treated and where
the Prosthetics transaction was created.

The Create Date is the date the transaction (Purchase Order or Stock 1ssue) was
created and posted to the Prosthetic veteran’s record (2319).

If the Delivery Date field is blank, this indicates that Prosthetics has NOT paid the
item; therefore an assumption is made that the veteran may not have received the
item.

The Delivery Dateis not the date the veteran received the item; it is technically the
date the Purchase Order was closed or the date the Stock | ssue transaction was
posted to the 2319.

The Patient column contains the veteran’' s last name and first name. Only Non-
Service Connected transactions display for the requested date range.

The SSN column displays the patient’ s Social Security Number (SSN).

Ea\fiew Prosthetic Billing Information ... You are logged onto SSCSL - |EI|1|
File Help

Please enter a range of dates to View Prosthetic Billing Information

Begining Date: NEARINER kS Ending Date: [¥ERIBAILHE kS Display

—*Site |Create Da. |Delivery D.. [Patient  |SSM Insurance |Coding .. |Ttem Qby |TotalC.. [HCPCS |HCPCS Desc  |ICDS  |ICDS Desc <
BAY PI1/13/2004 |1/13/2004 | GUHYJE,S| 009-38-! *MEDICARE R 9 36,00 E0443  PORT 02 COMI

BAY PI 1/13/2004 |1/13/2004 | CHE¥TAY,b060-25-1 *MEDICARE Alert HCP ~Re 1 49.00  E1401 OXYGEN CONI _I
BAY PT 1/13/2004 |1/13/2004 | CXEY¥TY.b 060-25-i *MEDICARE el 4 16.00 E0443 PORT 02 COMT

BAY PI1/13/2004 |1/13/2004  CHYHT,AA 300-24- *MEDICARE Alert HCP ~Re 1 49.00  E1401 OXYGEN CONI

BAY PT 1/13/2004 |1/13/2004 | CATHWE,( 264-28-i MO HEALTH Alert HCPY ~R~ 1 49.00 E1401 |OXYGEN COMNI

BAY PI 1/14/2004 |1/14/2004 | ALJELYIH, 019-33-' MO HEALTH R 9 36,00 E0443  PORT 02 COMI

BAY PI/1/14/2004 [1/14/2004 |ALJELYIH, 019-33-' MO HEALTH R 1 3,50 E0431  |PORTABLE GAS

View Prosthetics Billing Information 13
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View Column Description - Insurance Information

Insurancefor a The Insurance column displays health insurance information from the patient’s
patient VISTA record.

If there is no health insurance information in the patient’s VISTA record, it displays
“Nothing Found” in the I nsurance column.

If health insurance displays, then the most recent insurance entered into the patient’s
VISTA record will display.

| nsurance Ed view Prosthetic Billing Information ... You are logged onto SSCSL =101 x|
column .
Please enter a range of dates to View Prosthetic Billing Information
Begining Date: Ending Date:
—“Site | Create Da. |Delivery D.. |Patient Insurance |Coding .. |Item o] o JHCPCS
BAY PI1/13/2004 1/13/2004 | GUHYIE,S| 009-38-! *MEDICARE f 9 36,00 ED443 PORT 02 CONT
BAY PT 1/13/2004 |1/13/2004 | CREYTAY,b 060-25-1 *MEDICARE Alert HCPy ~R~ 1 49.00 E1401 |OXYGEN COMNI _I
BAY PI1/13/2004 1/13/2004 | CHEYTHY.H060-25-1 *MEDICARE f 4 16,00 ED443 PORT 02 CONT
BAY PT 1/13/2004 |1/13/2004 | CH¥YHT, A& 300-24- *MECICARE Alert HCPY ~Rie 1 49.00 E1401 |OXYGEN COMNI
BAY PI1/13/2004 1/13/2004 | CXTHWE,( 264-28- NO HEALTH Alert HCP1 ~Re 1 49,00 E1401 |DXEYGEN COMI
BAY PT 1/14/2004 |1/14/2004 |ALJELYIH, 019-33-! MO HEALTH R 9 36.00 EO443 PORT 02 COM
Asterisk If thereis an asterisk (*) in the I nsurance column, this indicates that there is more
than one insurance listed for the patient. If thereisno asterisk (*), then thereis only
ONE insurance listed for the patient in the VISTA record.
Click on that line item to display the insurance information in the box below.
Sorting Tip Y ou can sort on the column headers within the I nsurance | nfor mation box to group
itemstogether for easier review. For instance, you can click on the Effective date
column or Expires date column headers, and this will group items for reviewing the
most recent insurance.
Effa:tlve date Insurance |nformation Diizability Infarmation =
COI umn wrted Insurance ICOBISub 1] |Gr0up |HOIder| / EFfective IExpires ﬂ —Disahility % |3C
HUMARMA HEALTI P S515-41-/18 PATIER 02/01/2001 ERCMNCHITIS, CHROMIC YES
MEDICARE (WM 572-16- 33435 PATIEM 11/01/1997 SCARS 1} YES
MEDICARE (WM §36-65- 43745 PATIEM 11/01/1937 MEURCSIS, DYSTHYMIC DISCRD 10 YES
UMITED HEALTH 39164 PATIEM 11j01/1997 12{31/1995 ;I
@ Menu Records Found : 1255
January 2005 View Prosthetics Billing Information 14
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View Column Descriptions - Coding Errors

Coding Errors

Caoding Column

Sorting Tip

January 2005

The Coding Errors column isto aert Billing users of apossible error. Errors could
be any of the following:

= |nactive HCPCS
= |nactive ICD-9 codes
= Useof VA unique HCPCS codes.

The Coding Errors column checks the HCPCS code to see if it was valid at the time
of service, and if not, then the word “HCPCS’ is shown in red as well asthe
“HCPCS Description” isshown inred. This also appliesto the inactive ICD9 Codes.

Example: If thereisared HCPCS displayed in the HCPCS column, then the
Coding Errorscolumn will display “Alert HCPCS” for Prosthetics or Billing users.
Thiswill provide a mechanism to aert users to review this billing information.

Eab‘iew Prosthetic Billing Information . . .

You are logged onto SSCSL

=5l

File Help

Please enter a range of dates to View Prosthetic Billing Information

Begining Date: EYTNEERIE| Ending Dat ' [FESEEEIENE Display
—Site | Create Da, JDelivery D. . |Patient Insurance |Coding .. |Ikem Qt
BAY PT 1/13/2004 |1/13/2004 | GUHYIE,SI 002-38-! *MECICARE faa g 9 36.00 E0443 PORT 02 COMT
BAY PI 1/13/2004 1/13/2004 | CREYTAY,H060-25- *MEDICARE Alert HCP1 ~Rev 1 49,00 E1401 |OXYGEN COMI _I
RAY PTTIRIZONG (111307004 |CHFYTRY .} NRN-5-1 ¥MFDTCARF - 4 1R.00 (F443  [PORT N7 COMIT

Y ou can sort on the Coding Errors column by clicking the column header to group
itemsfor review.

View Prosthetics Billing Information 15
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View Column Descriptions - Item Information

Item definition

~R~in theltem
column

Item column
sorted — Repair
items grouped
together

January 2005

The Item column displays an Item or appliance kept in the Pros Master Item file.
This column displays the IFCAP Item description of the Item issued to the Veteran.

An*“~R~" displayed in the Item column represents a Repair item. The HCPCS
Description column should explain what was being repaired.

The Item column isthe “Brief Description” entry that is printed on the purchase
order transaction and appears on the 2319 record. The Brief Description is entered to
define the item.

Tip: You can sort on the Item column by clicking the column header to group items
to review all Repair items together.

File Help

Please enter a range of dates to View Prosthetic Billing Information

Begining Date: EIIFEERE| Ending Date: [FESEFETERE| Display

Insurance |Coding .. [-Item Oty [TotalC.. [HCPCS
ExMAXPTE 307-03- *MNO HEALTI BLAMKET 864,86 L3239
EXMAXPTE 307-03- *MO HEALTI ELASTIC SLPPOFR 2 25.12 LE239

#MNO HEALTI ELASTIC SUPPOF 34 45.10 L3239

#1O HEALTI POSTERICR. INTF /S0

HumMaNa H [PURPLEBAG 33 |

JALM, TN | 464-00- *HUMANA F

BAY P 1/16/2004
BAY P11/19/2004
BAY P 1/16/2004

ELASTIC SLPP:
ELASTIC SUPP:
ELASTIC SLPP

ELASTIC SUPP:

BAY I 1/13/2004 PURPLE ELANKET 29 5771.00 L8239

BAY I 1/13/2004 JALM, =M 464-00- *HUMANA F PURPLE KMEE BR 87 584205 L1800 KMEE ORTHOS

BAY PI 1/8/2004 | 1/8/2004 BDYFTS%Y 211-04- Mo Insuranc Alerk HCPY ~Rie 1 43,00 E1401 DXYGEN COMI

BAY PI 1/6/2004  1/8/2004  |BDZKAH,C 272-24-1 NO HEALTH Alert HCP1 ~Rev 1 49,00 E1401 |OXYGEN COMI

BAY PI 1/8/2004 | 1/8/2004 BDZkAH, C 272-24-1 MO HEALTH [ 4 16,00 E04435 PORT 02 CON1

BAY PI 1/8/2004  1/8/2004  |BDZKLAA,Y 458-14-1 *NO HEALTI Alert HCPY ~Rev 1 49,00 E1401 |OXYGEN COMI

BAY PI 1/8/2004  1/8/2004  |BDZKLAA, 458-14-1 *MNO HEALTI f 10 40,00 ED443 PORT 02 CONT

BAY PI 10902004 | 1/9/2004 | CXEYTHY,0 289-30-i MO HEALTH Alert HCPY ~Re 1 49,00 E1401 |OXYGEN COMI

BAI\" Pi 1/9/2004 1/9/2004  |CHEYTXY,( 289-30- MO HEALTH Rl 16 64,00 ED443 PORT 02 CONT lLI

a4 3
View Prosthetics Billing Information 16
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View Column Descriptions - Quantity and Total Cost Data

Qty column

Column
headers

Total Cost
column

January 2005

The Quantity column provides the number issued of that Item to the veteran. Thisis
the quantity based on purchasing (not units).

Note: For Home Oxygen, it is a payment unit not a billing unit.

Eab‘iew Prosthetic Billing Information ... You are logged onto S5C5L — IEllll
File Help

Please enter a range of dates to View Prosthetic Billing Information

—Site | Create Da, JDelivery D. . |Patient Insurance |Coding .. |Ikem Qt o HCPCS Desc  |ICDY

BAY PT 1/13/2004 |1/13/2004 | GUHYIE,SI 002-38-! *MECICARE faa g 9 36.00 E0443 PORT 02 COMT

BAY PI 1/13/2004 1/13/2004 | CREYTAY,H060-25- *MEDICARE Alert HCP1 ~Rev 1 49,00 E1401 |OXYGEN COMI _I
RA¥ PTUHAIPNNG 1ARIPIN4 [CRFYTRY . HNAN-75-1 *MFOTCARF ~oRes 4 1A.0N Fr44= PORT N2 COMT

The Total Cost column represents the cost of the issue.

View Prosthetics Billing Information 17
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View Column Descriptions - HCPCS and HCPCS Description

Data

HCPCS
definition

Red HCPCS

Column
headers

Asterisk in
HCPCS column
and Calculation
Flag

January 2005

The HCPCS acronym stands for Healthcare Financing Administration Common
Procedure Coding System. The HCPCS code represents an item or service. The
Prosthetics staff selects the HCPCS code when the transaction was created.

If the HCPC Code and HCPCS Description in the HCPCS and HPCPS Description
columns are red, that represents a HCPCS Code that has a coding error as defined by
an Inactive HCPCS.

This provides an dert to Prosthetics and Billing users as this will affect billing
information.

Ea\fiew Prosthetic Billing Information ... You are logged onto SSCSL - |EI|1|

File Help

Please enter a range of dates to View Prosthetic Billing Information

Begining Date: NEARINER kS Ending Date: [¥ERIBAILHE kS Display

" Site | Create Da. |Delivery D, [Patient Insurance |Coding .. |Ttem

o |HCPCS

1/13/2004 | GUHYIE, S| 009-38- *MEDICARE R 36,00 EO443  |PORT 02 COMT
1/13/2004 |CXE¥TAY,t 060-25- *MEDICARE Alert HCPY ~Re 49.00 E1401 |OXYGEN COMI
1/13/2004 | CREYTAY . 060-25- *MEDICARE R EO443  |PORT 02 COMT

1/13/2004 | CXYHT,AM 300-24- *MEDICARE Alert HCP1 ~fie
111312004 | CXTHWE, (| 264-26-i MO HEALTH Alert HCP1 ~fie
1/14/2004 | ALJELYIH, 019-33-' MO HEALTH R
1/14/2004 ¥JH, 019-33-' MO HEALTH s
| EMARPT] 0 HEALTI LIPPOF| 34 5230 [FL ASTIC SLIPR|
BAY PI 1/16/2004 EXMAKPTE 307-03-*M0 HEALTI POSTERIOR IMTFS0  5940,00 ¥2632*  POSTERIOR IM
BAY PT 1/16/2004 BXMAYPTE 307-03- *NO HEALTI BLAMKET 13 &o4.80  LB239 ELASTIC SUPP:
BAY PT 1/19/2004 BXMAYXPTE 307-03- *NO HEALTI ELASTIC SUPPOR 2 25,12 L5239 ELASTIC SUPPt

49.00 E1401 |OXYGEN CONI
49,00 E1401 |OXYGEM CONI
36,00 EO443  |PORT 02 COMT
PORTABLE GAL

[ Yo P Py g P PO P
o
o
=

If thereis an asterisk in the HCPCS column, this indicates that there is a calculation
flag.

A calculation flag determines whether or not a HCPCS is used as a Main Component
to display the entire cost of a purchase, when multiple items within the purchase
make up awhole (e.g., when purchasing a limb or surgical implants).
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View Column Descriptions - ICD9 and ICD9 Description

ICD9 definition

Column
headers

ICD9 Code
Selection

January 2005

International Classification of Diseases (Ninth Revision) -A coding system designed
by WHO, (World Health Organization). ICD-9-CM isthe official system of
assigning codes to diagnoses and procedures associated with hospital utilization in
the United States.

The ICD —9isused to code and classify mortality data from death certificates.
VOLUMES 1-2 contain diagnosis and procedures. VOLUME 3isused for
statistical, research and re-imbursement purposes.

=lolx|

You are logged onto SSCSL

Ea\fiew Prosthetic Billing Information . . .
File Help

Please enter a range of dates to View Prosthetic Billing Information

Begining Date: \EYNEERIE| Ending Date: FEEEEEIENE Display
—Site | Create Da, JDelivery D. . |Patient Insurance |Coding .. |Ikem Qt HCPCS Desc
BAY PI1/13/2004 |1/13/2004 | GUHYJE,S| 009-38-! *MEDICARE f 9 36,00 ED443 PORT 02 CONT
BAY PI 1/13/2004 |1/13/2004 | CHE¥TAY,b060-25-1 *MEDICARE Alert HCP ~Re 1 49,00 E1401 |OXYGEN COMI _I
RAY PTMEIPNNG 1ARPNG | CHFYTHY HNAN-25-1 FMFOTCARF e 4 1A.00 FN443  PORT N2 COMT

This code is selected by the prescribing clinician when the Prosthetic consult is
created.
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View Column Descriptions - Disability Information

Disability If the patient has disability information, it will automatically be displayed in the
Information Disability Information box in the bottom of the window.

If apatient is selected without any disability information, the Disability
Information box at the bottom of the window will display “Nothing Found.”

D| Sab| I |ty Ea\fiew Prosthetic Billing Information ... You are logged onto SSCSL -0l x|
File Help
sample
Please enter a range of dates to View Prosthetic Billing Information
—Site |Create Da. |Delivery D Insurance |Coding .. |Item ot
1/13/2004 | GUHYIE,SI 009-38-! *MEDICARE R . PORT 02 COMT
1/13/2004 | CHEYTHY,HO60-25- *MEDICARE Alert HCP1 ~Re o OXYGEN CONI
1/13/2004 | CHEYTXY b 060-25- *MEDICARE it . PORT 02 COM1
111372004 | CevHT, AA 300-24- *MEDICARE Alert HCPy ~Re o OXYGEN CONI
1/13/2004 | CHTHWE,( 264-28- MO HEALTH Alert HCP1 ~Re . OXYGEN CONI
BAY PI 1/14/2004 |1/14/2004  ALJELYIH, 019-33-! NO HEALTH fala el 0 PORT 02 COMNT
BaY PT 1/14/2004 |1/14(2004 ! . PORTAELE GAS
EaY PI1116 ; ) HE A 34 [45.10 |ELAS op|
Bia P 1/16/2004 EXMARXPTE 307-03- *MO HEALTI POSTERIOR, TMTF S 5940.00 ¥2632*  POSTERICR IM
BAY PI 1/16/2004 ExMAXPTE 307-03- *MO HEALTI BLAMKET 13 86486 L8239 ELASTIC SLPP
BAY P1 1/19/2004 ExMAXPTE 307-03- *MO HEALTI ELASTIC SUPPCE 2 25.12 L3239 ELASTIC SLPP
BAY PI 1/19/2004 |1/19/2004  KLRHU,PD 713-00- MO HEALTH Alert HCPY ~Ree 1 49.00 E1401 |OXYGEN COMNI
BAY PI 1/19/2004 1/19/2004 KLRHU,PD 713-00- MO HEALTH R 7 28.00 E0443 PORT 02 CONT
BAY PT1/19/2004 1/19/2004  KHUYISTX031-00- *MEDICARE R 10 140,00 E0443 PORT 02 CONT hd
4 >
Insurance |nformation Diizability [nfarmation
SInsurance OB |Sub ID |Group |Holder |Effec Expires
MO HEALTH INSL 38118 PATIEM 0Z/14/2002 |02/14/2002 KMEE COMDITION 30 YES
SEPTUM, MASAL, DEVIATION OF a YES
COMDITION OF UPPER. DIGESTIVE SYSTEM o YES j
Menu | Records Found : 1255
|click on Header to SORT or MOVE v
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Section 4 - Printing

Print the View Prosthetics Billing Information Window

Print thedata  You can print the View Prosthetics Billing Infor mation data after you have
finished your sort by column heading. Click the Print button to send this
information to your local printer, and click OK on the Print dialog box. (You can
aso click the File Menu and the Print option.)

Note: The layout of the print will be the same asthe display. You can select a
specific printer to print the View Prosthetics Billing I nfor mation window.

Changeto Recommendation: Y ou should change the format of the printout from Portrait to
L andscape Landscape to print al the columns on the same page.
Steps To change the print format, follow these steps:
Step Action
1 Click the Print button on the View Prosthetics Billing I nfor mation
window.

2 Click the Properties button (to the right of the Name field) on the Print
dialog box. Continue to the next page.

Shortcut: Pressthe <Alt> key + <P> key.

Print dialog print 2 x|
box — Printer

Mame: HF Laserlet 4 Properties. .. |

Statug: Ready

Type: HF Lazerlet 4

“Wheree  LPTT:

Comment:

r— Print range Copies
& al Murmber of copies: I'I 3:
) Pages from:l to:l
) ) [¥ Collate
") Selection
ar. I Caticel
Continued on next page
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Print the View Prosthetics Billing Information Window,

Continued

Layout Tab

Steps
(continued)

L andscape
Radio button

Last step

January 2005

Y ou can change the format of the printout from the standard Portrait format to
Landscape on the L ayout tab.

To continue to change to the Landscape format, follow these steps:

Step Action

3 Click the Layout tab on the Properties dialog box (usually shown asa
default view).

4 Click the L andscape radio button to change the format.

Shortcut: Pressthe <Alt> key + <L > key.

5 Click OK or press <Enter.>

&% HP LaserJet 5 Document Properties 2|

Lapaut | Paper/Guality |

r— Origntation

" Paortrait P
& Landssaps

— Print on Both Sides(Duplex) —
' Mone
" Flip on Long Edge

S
" Flip on Short Edge =

— Page Order

* Front to Back
" Back to Frant

Pages Per Sheet: I 1 ‘I

Adwvanced... |
(1]4 I Cancel |

When you return to the Print dialog box, click OK again, and it will print your
output. You can print multiple copies if necessary.
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Section 5 — Saving

Save as an Excel File

Excel Button

Steps

Security
Reminder

January 2005

Click the Excel button on the View Prosthetics Billing I nfor mation window to
launch Excel and display the current data. (Y ou can also click the File menu and
select the Excel option.)

Shortcut: Pressthe <Alt> key + <X> key to launch MS Excel.

Note: Thisfeature creates atemporary Excel .CSV filein the folder selected. The
default folder is C:\ViewBillingDownload (which is automatically created). Thefile
name is based on the date range.

Example: Jul 02, 2006_Aug 10, 2006.csv

Prior to the display, you are notified that the information about to be exported
may contain Patient Identifiable Information.

To export datato Excel:
Step Action
1 Click the Excel button on the View Prosthetics Billing Information
window.

Shortcut: Pressthe <Alt> key + <X> key.

2 Click the OK button on the security reminder.

3 Continue to the Select Directory window.

Security Reminder

The data you are about ta expart may contain Patient Identifiable Information, which requires appropriate measures to ensure its confidentiality. Please select
only a secure, encrypted location to save this data,

Step Action

4 Navigate to the desired directory and select OK .(Click Cancel to exit or

Help to view the help pages associated with this functionality)
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Select Directory

X

Select Directorny

Directary M ame:
|C:\iewBilingD ownload

Directaries: Eiles: [7.%]

Dryives:
|E= & [windows] -]

k. Cancel |

Step Action

5 Navigate to a secure location where the temporary Excel (.csv) file will
be stored and then select OK . Excel will open and display the data.

Cont'd.
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M S Excel data Fd Microsoft Excel - Feb 01, 2004_Apr 30, 2004.csv -0l x|

@ File Edit Wiew Insert Format Tools Data  Window Help  Adobe PDF Twpe a question for help [« /2 @ X
DEE & < B 2 aa -0 - B I U S=E=EBE$%[E| o -h-A- 2
{3 ®a %8 A T ¥a | ¥ W ) | YeReply with Changes... End Review... |
T B ] .
Al - A Site

A 108 | ¢ | o | E | F | & [ H [ 1 [ J [ K [
1 [Site Create Dat Delivery DePatient  SSN Insurance Coding Errltem Gty Tatal Cost HCPCS  H™
| 2 |SUPPORT 2/18/2004 01/01/0001DANGER |666-89-07E Mo Insuran Non Billial Battery 1 2 BA00 R
| 3 |SUPPORT 2/26/2004 01/01/0001 DANGER,|666-89-07E Mo Insurance Informat Eyeglass f 1 25,99 Ad4254 B
4
5
| 6 |
| 7|
| 8 |
| 9|
| 10|
|11 |
112
113
| 14 |
| 15|
| 16 |
| 17 |
18 | —
19 <
W 4 > W\Feb 01, 2004_Apr 30, 200+ /A E—— [ | | ;IJ_I
Ready S

Step Action

6 Thisis only atemporary file so if you wish to save the data you must
select File, then Save As, then change the name of thefile.

Note: To savethefile, you must change the filename from the default. I
you accept the default file name, it will be deleted when you close the

NPPD window.
Temp file Should you wish to check the location of the temp file, it displays on the View
location Prosthetic Billing window right above the Excel button.
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**Note**

Attempting to
Open another
report with
temp file till
open

Attempting to
navigate away
from the View
Prosthetic
Billing

I nformation
window with
temp file still
open

January 2005

Y ou will be unable to export another report to Excel or navigate away from the View
Prosthetic Billing Information window until the current Excel (.csv) fileis closed.
Attempting to do so without first closing the file will result in one of the following
errors depending on what action has taken place. If you do save afile with Patient
Identifiable Info in it, don't forget to delete it when you no longer need it.

Error Encountered [Z”E”z|

Please close the temporary Excel {.csv)
file before continuing

Error Encountered

Please close the temporary Excel {.csu)
file before navigating from this form
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Section 6 - Closing and Exiting

Exit the View Prosthetics Billing Information Window

Exit the
Application

Confirmation
window

Cancel button

January 2005

Y ou can exit the application by first clicking the M enu button on the View
Prosthetics Billing Infor mation window. Then click the Close button on the Main
Prosthetics window:

x

€ |, Are you sure you want ko EXIT khe Prosthekics application Suite?

L]
Cancel |

o

If you click the Cancel button, you will remain in the application and can continue to
work.
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Appendix A
Getting Help

F1Key Online Help can be accessed in three methods:

1. Click the Help Menu (located in the upper left corner of the menu bar) and
the Contents option.

2. Pressthe <F1> key.
3. Pressthe <Alt>key + <H> key. (Thisactivatesthe Help Menu, not the
Billing contents.)
H el p M enu Ea\fiew Prosthetir Billing Information ... You are logged onto DEY

File Help

Please enter a range of dates to View Prosthetic Billing Information

Begining Date: YTIEFRH| Ending Date: ERIETEIERE Display
--m- 1CD9 Desc

SUPPC 2.I'26.I’2004 DANGER, L 453-89-1 Mo Insuranc Evealass For asty 1 29 99 A4254 BATTER\" FOR (730, 86 BOME INFECT I

Insurance |nformation Dizability Infarmation

SInsurance COB |Sub ID |Group |Holder |Effective  |Expires A Disability e |SC

) Menu | Records Found : 2
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Appendix B

Activate Section 508 Assistance

I ntroduction

Steps

Confirmation
message

January 2005

Y ou can change the colors of the screen to black/white, which is required for Section
508 requirements to be read by visually and hearing impaired veterans.

This feature can be updated from the Help Menu. It provides atoggle to go back
and forth between using the colors or the black/white screens depending on your
needs.

To activate the Section 508 assistance, follow these steps:

Step Action

1 Click the HeIE Menu, and click the Section 508 option.

Help
Contents Fl1

Section 508 Chrl+5

About Crl+A

Shortcut: Pressthe <Ctrl> key + <S> key.

N

Click OK on the confirmation message dialog box as shown below.

3 Click OK again to exit out of the system and restart to activate the
changes.

View Prosthetics Billing Information 29
Patch RMPR* 3* 96




	Revision History
	Table of Contents
	Overview
	Section 1 – For Billing Users
	Section 2 – For Prosthetics Users
	Section 3 – View Billing Information Package
	Section 4 – Printing
	Section 5 – Saving
	Section 6 – Closing and Exiting
	Appendix A
	Appendix B

